
Fundamentals of Computer Science I (CS151.01 2006F) 

Laboratory: Getting Started in the MathLAN
Summary: This laboratory reviews some mechanics related to the use of the Computer Science
Local-Area Network (MathLAN) for CSC151. Specifically, this lab discusses:

Logging In 
The Linux/Gnome Window Environment 
Practice with a Terminal Window: Changing Your Password 
Firefox 

Firefox Options 
Using Thunderbird for Email 

Adding an Icon to the Task Bar 
Configuring Thunderbird 
Getting Mail 
Making Firefox and Thunderbird Play Together 

Using Thunderbird for Mail Links 
Using Firefox for URLs in Mail 

Finishing Up and Logging Out

Please don’t be intimidated! Although this lab contains many details which may seem overwhelming at
first, these mechanics will become familiar rather quickly. Feel free to talk to the instructor or with a
MathLAN User Consultant if you have questions or want additional help!

Logging In
Short Version

On the computer in front of you, you should see a small window that asks you to log in. If you don’t
see such a window, try hitting a key on the keyboard or clicking the power button on the monitor. 
Enter your user name. Press the <Enter> key. 
Enter your password (which won’t appear). Press the <Enter> key. 
Get help if those previous two steps don’t work.

To use any of the computers in the MathLAN, one must log in, identifying oneself by giving a user name
and a password. You will have received a MathLAN user name and password from the instructor if you
did not already have one. If you have not received a MathLAN user name and password, or if you have
forgotten either one, please tell your instructor.

When a MathLAN workstation is not in use, it will display a login screen with a space into which one can
type one’s user name and, later, one’s password. (If the workstation’s monitor is dark, move the mouse a
bit and the login screen will appear.) To begin, move the mouse onto any part of the box containing the
login box. Type in your user name, in lower-case letters, and press the <Enter> key. The login screen will
be redrawn to acknowledge your user name and to ask for your password; type it into the space provided
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and press <Enter>. (Because no one else should see your password, it is not displayed on screen as you
type it in.) 

At this point, a computer program that is running on the workstation consults a table of valid user names
and passwords. If it does not find the particular combination that you have supplied, it prints a brief
message saying that the attempt to log in was unsuccessful and then returns to the login screen -- inviting
you to try again. Consult the instructor or the system administrator if your attempts to log in are still 
unsuccessful.

The Linux/Gnome Window Environment
Short Version

You’ll see something that looks somewhat like Microsoft Windows, but also somewhat different. 
Icons at the bottom of the screen can be used to start programs.

Once you have logged in, a control panel will appear at the bottom of the screen. Some other windows
also may be visible in other parts of your screen. All of these areas are managed by a special program,
called a windowing system. On MathLAN, login chores and other administrivia are handled by a program
or operating system, called Linux, and the windowing system is called Gnome. 

Practice with a Terminal Window: Changing Your Password
Short Version

Click on the picture of the small computer monitor with a prompt. A new window, called the
Terminal, will appear. 
Type yppasswd and hit the <Enter> key to change your password. You will be prompted for your
old password and your new password. 
Type exit and then hit the <Enter> key to close the window.

While we can run several programs directly, we will need to invoke others by name. The computer
program that reads and responds to such invocations is called the shell, and your interactions with the shell
takes place in a window generated by a program called a terminal emulator, or terminal for short. 

You may already have a Terminal window on screen. If not, you can start one at any time by moving the
pointer onto the small monitor icon at the bottom middle of the front panel, and clicking with the left
mouse button. Shortly a window appears, displaying the shell prompt -- the name of the workstation on
which the shell is running, followed by a percentage sign. This prompt indicates that the shell is ready to
receive instructions.

You type in such instructions using the keyboard. Move the mouse pointer into the Terminal window and
click the left mouse button to make the window active. Notice that the window frame changes color
following the click, indicating that the window has become active.
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To get rid of the Terminal window, press <Ctrl/D>. That is, hold down either of the keys marked <Ctrl>,
just below the <Shift> keys, and simultaneously press the <D> key. (On our workstations’ keyboards, the
keys marked <Ctrl> (“control”) and <Alt> (“alt” or “meta”) are somewhat like <Shift> keys, in the sense
that they modify the effect of other keys that are pressed simultaneously.) The shell program interprets
<Ctrl/D> as a signal that you have no more instructions for it and halts, and the terminal emulator closes
the window automatically once the shell stops running. Alternatively, you may close a window by moving
the mouse to the x at the top-right of the window, and clicking the left mouse button. Finally, you can
usually type exit to close a terminal window.

It is a good idea to change the password associated with your account shortly after you receive it and every
few months thereafter. The program that one uses to change one’s password is by its name, “yppasswd”.

Choose a new password. Make it something that you can easily remember, but not an English word or a
name, since it is easy for system crackers to break in by guessing your password if you choose it from one
of those categories.

Open a terminal window, select the window by clicking the left mouse button in it, and type the word 
yppasswd. The password program prompts you once for your old password -- the one you logged in
with -- and twice for your new password. If you give your old password correctly and the two copies of
your new password match, the program substitutes the new password for the old one in the table that the
login program consults. The old password is discarded and will not be recognized in subsequent logins. (If
the attempt to change the password fails for any reason, however, the old password is retained.) 

A typical interaction to successfully change a password looks like this:

   bourbaki% yppasswd
   Changing NIS account information for user on hopper.math.grin.edu.
   Please enter old password:
   Changing NIS password for user on hopper.math.grin.edu.
   Please enter new password:
   Please retype new password:

   The NIS password has been changed on hopper.math.grin.edu.

   bourbaki%

After running the yppasswd program, the shell takes over again and issues another prompt. You can
invoke as many programs as you like from the shell, one after another, before pressing <Ctrl/D> or exit
to leave the shell.

Firefox
Short Version

Start Firefox by clicking on the picture of the Earth. 
Agree to any dialog boxes that appear. They shouldn’t appear again. 
Learn how to get to the front door for this class.
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Almost all of the materials for this course will be distributed over the World Wide Web rather than in
paper copies. To view materials, such as this course’s syllabus and this lab, you may follow these steps:

First, prepare to use the World Wide Web by clicking on the Firefox icon (the picture with the blue globe
at the bottom panel of the screen). (And no, I don’t know why we use a blue globe rather than the
cooler-looking red fox encircling a blue globe.) The first time you run Firefox on MathLAN, two message
boxes might appear.

One box might ask you to consent to the terms of a licensing agreement. 
One box might request permission to create some configuration files in your home directory.

You should approve of any requests by clicking on the appropriate word. The pop-up boxes then
disappear; you should not see them on subsequent uses of Mozilla.

Initially, Firefox displays a World Wide Web document containing some default information. You should
switch to the page http://www.cs.grinnell.edu/zero-one.xhtml, which is an entry point to
the Computer Science Department’s Web site.

I expect that most of your are already familiar with a Web browser. If not, please consult with me or one
of your colleagues.

To find material for this course, scroll down the “origin” page for the Computer Science Department to the
list of course front doors. Now scroll down this page to find the entry for this course, Fundamentals of
Computer Science I, Section 1, and click on it to locate the front door for this course. Next, click on the 
Syllabus link to view the current draft of the semester’s schedule. If you click on the Current link, you’ll
see an outline of today’s class.

You can also connect to the Web page for this class by selecting Open Web Location from the File menu
and then entering http://www.cs.grinnell.edu/~rebelsky/Courses/CS151/2006F/

Firefox Options

Short Version

Select Preferences from the Edit menu and update your home page to something reasonable like this
course’s front door or the Outlook Web Access page.

Each MathLAN user can configure Firefox to reflect her or his own preferences. Between logins, these
preferences are stored in a file in the user’s home directory; when Firefox is started during a later session,
they are reinstated from that file.

Every user of Firefox on MathLAN should establish a base page, a starting point for browsing. Here are
the Uniform Resource Locators or URLs of some good choices: 

The front-door for this course: 
http://www.cs.grinnell.edu/~rebelsky/Courses/CS151/2006F/. 
The current class outline: 
http://www.cs.grinnell.edu/~rebelsky/Courses/CS151/2006F/Outlines/current.hmtl. 
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The departmental origin http://www.cs.grinnell.edu/zero-one.xhtml 
Grinnell College’s front-door page (oh boy!) http://www.grinnell.edu 
Microsoft Outlook Web Access http://mail.grinnell.edu 
A page you create.

To establish your base page, within Firefox, bring up the Edit menu from the menu bar and select the
Preferences operation. A pop-up window appears, allowing you to configure many features of the general
appearance of Firefox. Choose the General option, if it has not been chosen already. The rectangle labeled 
“Home Page” contains the URL of some document that serves as the default. Replace the contents of this
rectangle with the URL of your choice. (This does not have to be a permanent change; you can change
your mind about this configuration at any time within Firefox.)

To erase the current contents of the “Home Page Location(s)” box, move the mouse pointer to the left of
the first character in the box, press the left mouse button and hold it down, and drag the mouse pointer
rightwards until the entire URL is displayed in reverse video, white letters on a black background. Then
release the left mouse button and type the new URL; the old one will vanish as soon as you start typing.
Once you have entered the new URL, move the mouse pointer onto the button marked OK at the bottom of
the pop-up window and click on it with the left mouse button.

You can, of course, simply navigate to the page you want to use as your home page and then click on Use
Current Pages.

You may note that the button says “Pages” (plural) rather than “Page” (singular). Since Firefox permits
tabbed browsing (that is, you can have “tabs” within the same window that you switch between), you can
have a home set of tabs. Particularly obsessive people might want to set up a sequence of tabs with say, the
current outline, the current eboard, the current reading, the current lab, and Plans (for when you get bored).

Using Thunderbird for Email
While you probably use Microsoft Outlook Web Access for most of your email, you can also use
Thunderbird, which works well on Linux, Macintosh, and even Microsoft Windows (at least when it’s
configured right). So that you can send email appropriately within the MathLAN, I’d like you to configure
Thunderbird as a mail client. Most importantly, Thunderbird lets you use the mailto links that
sometimes appear in pages.

Adding an Icon to the Task Bar

Your first task in getting Thunderbird running correctly is to add a Thunderbird icon to the task bar.
(Almost as importantly, once you figure out how to add a Thunderbird icon, you will be able to add other
applications that you want to use.)

Short Version

Right-click on the task bar. A pop-up menu should appear. 
Select Add to Panel ... from that menu. 
A dialog box will now appear. Click on Application Launcher and then Forward. 
A long list of categories of applications should appear. Scroll down, and then open the list of Internet
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applications. (Click on the triangle to open the list.) 
Scroll down again until you see Thunderbird Mail Client. Click on that button. 
Click on Add. 
Click on Close.

If you’ve done everything to the satisfaction of the computer (and, as you recall, computers like to
misinterpret what you’ve asked, so they can be hard to satisfy), you should now have an icon for
Thunderbird in your task bar. If you don’t, please obtain help from a teacher or teaching assistant.

Finally, click on the icon to start Thunderbird.

Warning: For unknown reasons, Thunderbird currently seems to take an insanely long time to start.

Configuring Thunderbird

You’d hope that you could now read mail, wouldn’t you? Unfortunately, Thunderbird needs to know
which email account to use. Hence, you need to answer a series of questions.

Thunderbird may ask whether it should import information from some other email package. Tell it not to.
If all goes well, it will then prompt you to set up a new account. You will be setting up an Email account.
Please use your name and your Grinnell email address for the Identity.

In the Server Information dialog box, select IMAP, use mail.grinnell.edu as the incoming server,
and use mail.grinnell.edu as the outgoing server, too.

Getting Mail

Once you’ve configured Thunderbird, you should be able to read your Grinnell College email. Spend a
few minutes getting acclimated to Thunderbird. Try to send at least one message (e.g., to me). Send a
message to yourself that includes a URL (e.g., “The CSC151 site is 
http://www.cs.grinnell.edu/~rebelsky/Courses/CS151/2006F/. I can’t believe that
Rebelsky uses such long URLs.”)

Spend no more than five minutes reading email. (And no, don’t tell all your friends “My assignment in
151 was to read email”.)

Making Firefox and Thunderbird Play Together

Unfortunately, even though Firefox and Thunderbird were written by the same people, Firefox thinks it
should launch a different mail reader when you try to send mail or click on a mailto link, and
Thunderbird thinks it should launch a Web browser other than Firefox. (Just remember, “Sentient and 
Malicious”.) Hence, you need to teach them about each other. (Don’t worry; if everything goes well,
you’ll never have to do it again, at least not this semester.)
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Using Thunderbird for Mail Links

Let’s starting by making Firefox use Thunderbird to send mail. 

Short Version

Type "about:config" into the location bar (where you normally see something that begins with http)
and hit return. 
Right click in the window. Select the New submenu. Select String from that submenu. 
A dialog box should appear that prompts you for the preference name. Enter 
network.protocol-handler.app.mailto 
Another dialog box will appear that prompts you for the preference value (which it may call a “string 
value”). Enter /usr/bin/thunderbird. 
Restart Firefox. (Sorry, you’ll then have to re-navigate to this lab.) 
Click on this link. If all goes well, a composition window should appear in which you can send me
and my teaching assistant a message. If not, see if you can figure out what went wrong (“Yeah, 
right”, you’re probably thinking) and then get help from a teacher or teaching assistant.

I should insert a long discussion here to match the structure of the other sections, but I’m feeling lazy right
now. Suffice to say, there are lots of silly things going on, but there’s no real intellectual benefit in
learning about this stuff (at least not at this stage of your career).

Using Firefox for URLs in Mail

Let’s continue by making Thunderbird use Firefox to open URLs. These steps, believe it or not, are even
more convoluted than those you did above. (No, you may not tell your friends “I spent all of CSC151
following stupid and unexplained instructions that did nothing more than configure my Web browser and
mail reader to work correctly”.)

Short Version

From Thunderbird’s Tools menu select Extensions. 
A window should appear. Click on the Install button on the lower left. 
A dialog box should appear, asking you for the path to an extension. Enter 
/home/rebelsky/Extensions/aboutconfig-0.6.xpi. 

Click on the left arrow by your name. 
Click on the home button. 
Scroll down and double-click on rebelsky 
Scroll down and double-click on Extensions 
Double-click on aboutconfig-0.6.xpi

Click Open 
Yet another window will appear. Wait a few seconds. You should see an Install appear. Click it. 
Restart Thunderbird.
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Believe it or not, but all that you accomplished with those steps is to make Thunderbird let you configure
it. Let’s hear it for sensible design.

From the Tools menu, select About:config. 
A new window should appear. Whee. 
Right click in the window. Select the New submenu. Select String from that submenu. 
A dialog box should appear that prompts you for the preference name. Enter 
network.protocol-handler.app.http. 
Another dialog box will appear that prompts you for the preference value (which it may call a “string 
value”). Enter /usr/bin/firefox. 
Right click in the window. Select the New submenu. Select String from that submenu. 
A dialog box should appear that prompts you for the preference name. Enter 
network.protocol-handler.app.https. (Note that this step differs from the incredibly
similar previous step in that you added an s.) 
Another dialog box will appear that prompts you for the preference value (which it may call a “string 
value”). Enter /usr/bin/firefox. 
Restart Thunderbird. 
In an earlier exercise, you should have sent yourself an email containing a link. (If not, do so now.)
Click on that link. If the computer is cooperative, the link should open in Firefox. If not, get help.

The “short version” was so long that there is no way that I’m going to write a longer, narrative version, at
least not in the near future.

Finishing Up and Logging Out
If you’ve successfully logged in, changed your password, started Firefox, selected your base page, started
Thunderbird, made Firefox and Thunderbird play together, and sent me some email, you’ve completed the
lab and you can finally stop. 

Short Version

To log out, click on the menu icon near the lower left, select Log out, and confirm. 
Do not turn off the monitor or computers.

When you are done using a workstation, you must log out in order to allow other people to use it. To log
out, move the pointer onto the menu icon near the left of the front panel, click the left mouse button, and
select the Log out option. A confirmation box will pop up, asking you to verify that you’re ready to log
out; move the pointer onto the word Yes near the bottom of this box and click the left mouse button. The
Gnome windowing system vanishes, and after a few seconds the login screen reappears; this confirms that
you’re really logged out.

Please do not turn off the workstation when you are finished. MathLAN workstations are designed to
operate continuously; turning them off and on frequently actually shortens their life expectancy.

Copyright © 2006 Samuel A. Rebelsky. This work is licensed under a Creative Commons
Attribution-NonCommercial 2.5 License. To view a copy of this license, visit 
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http://creativecommons.org/licenses/by-nc/2.5/ or send a letter to Creative
Commons, 543 Howard Street, 5th Floor, San Francisco, California, 94105, USA. 
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